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artus HAV TM RT-PCR Kit v2.0
For use with the ABI PRISM 7000, 7700 and 7900HT Sequence Detection
Systems.
For research use only. Not for use in diagnostic procedures.
Attention: The artus HAV TM RT-PCR Kit v2.0 may neither be used in
®

combination with the GeneAmp 5700 SDS nor with the 384 plate format of
the ABI PRISM 7900HT SDS.

1. Contents
Labelling
and contents

Art. No. 4516103
24 reactions

Blue

HAV TM Master 1

2 x 12 rxns

Violet

HAV TM Master 2

2 x 12 rxns

¤

Red

HAV TM QS 1
5 x 103 IU/µl

1 x 200 µl

Red

HAV TM QS 2¤
5 x 102 IU/µl

1 x 200 µl

Red

HAV TM QS 3¤
5 x 101 IU/µl

1 x 200 µl

Red

HAV TM QS 4¤
5 x 100 IU/µl

1 x 200 µl

Green

HAV TM IC¤

1 x 1,000 µl

White

Water (PCR grade)

1 x 1,000 µl

¤

QS
IC

=
=

Quantitation Standard
Internal Control
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2. Storage
The components of the artus HAV TM RT-PCR Kit v2.0 should be stored at
-20°C and are stable until the expiry date stated on the label. Repeated
thawing and freezing (> 2 x) should be avoided, as this may reduce the
sensitivity. If the reagents are to be used only intermittently, they should be
frozen in aliquots. Storage at +4°C should not exceed a period of five hours.

3. Additionally Required Materials and Devices
y

Disposable powder-free gloves

y

RNA isolation kit (see 7.1 RNA Isolation)

y

Pipettes (adjustable)

y

Sterile pipette tips with filters

y

Vortex mixer

y

Desktop centrifuge with rotor for 2 ml reaction tubes

y

Centrifuge with rotor for microtitre plates (optional)

y

96-well reaction plate/reaction tubes for optical measurement with
corresponding optical closing materials♦ (see 7.4 Preparing the
PCR)

y

96-well two-part retaining rack for use with optical reaction tubes
(96-Well Tray/Retainer Set, Cat. No. 403 081, Applied Biosystems),
see 7.4 Preparing the PCR

y

Compression pad for use with optical adhesive covers (Optical Cover
Compression Pads, Cat. No. 4 312 639, Applied Biosystems), see
7.4 Preparing the PCR

y

Applicator for sealing of the reaction plates using optical adhesive
covers (Adhesive Seal Applicator Kit, Cat. No. 4 333 183, Applied
Biosystems)

y

♦

ABI PRISM 7000, 7700 or 7900HT SDS

The use of reaction tubes for optical analyses with domed caps is only permitted with the
ABI PRISM 7700 SDS and requires an adjustment of the exposure time (see
7.5.2 Programming the ABI PRISM 7700 SDS, 7.5.2.5 Important Additional Settings).
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Attention: A valid calibration of the pure dyes (Pure Spectra Component File)
and the background (Background Component File) is necessary when putting
the instruments into operation.

4. General Precautions
The user should always pay attention to the following:
y

Use sterile pipette tips with filters.

y

Store and extract positive material (specimens, controls and
amplicons) separately from all other reagents and add it to the
reaction mix in a spatially separated facility.

y

Thaw all components thoroughly at room temperature before starting
an assay.

y

When thawed, mix the components and centrifuge briefly.

y

Work quickly on ice or in a cooling block.

artus HAV TM RT-PCR Kit v2.0 12/2010

7

5. Principle of Real-Time PCR
Pathogen detection by the polymerase chain reaction (PCR) is based on the
amplification of specific regions of the pathogen genome. In real-time PCR the
amplified product is detected via fluorescent dyes. These are usually linked to
oligonucleotide probes which bind specifically to the amplified product.
Monitoring the fluorescence intensities during the PCR run (i.e. in real-time)
allows the detection and quantitation of the accumulating product without
having to re-open the reaction tubes after the PCR run (Mackay, 2004).

6. Product Description
The artus HAV TM RT-PCR Kit v2.0 constitutes a ready-to-use system for the
detection of HAV RNA using polymerase chain reaction (PCR) in the ABI
PRISM 7000, 7700 and 7900HT Sequence Detection System. The
HAV TM Master 1 & 2 contain reagents and enzymes for the reverse
transcription and specific amplification of a 90 bp region of the HAV genome.
The amplicon is detected by measuring the FAM fluorescence in the ABI
PRISM SDS. In addition, the artus HAV TM RT-PCR Kit v2.0 contains a
second heterologous amplification system to identify possible PCR inhibition.
This

is

detected

as

an

Internal

Control

(IC)

by

measuring

the

VIC fluorescence. The detection limit of the analytical HAV RT PCR (see
10.1 Analytical Sensitivity) is not reduced. External positive controls
(HAV TM QS 1 - 4) are supplied which allow the determination of the
pathogen

load.

For

further

information,

please

refer

to

section

7.3 Quantitation.
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7. Protocol
7.1 RNA Isolation
Various manufacturers offer RNA isolation kits. Sample amounts for the
RNA isolation procedure depend on the protocol used. Please carry out the
RNA isolation according to the manufacturer’s instructions. The following
isolation kits are recommended:
Sample
Material

Serum,
plasma

y

Nucleic Acid
Isolation Kit

Catalogue
Number

Manufacturer

Carrier RNA

QIAamp® UltraSens®
Virus Kit (50)

53 704

QIAGEN

included

QIAamp Viral RNA
Mini Kit (50)

52 904

QIAGEN

included

QIAamp DSP
Virus Kit (50)

60 704

QIAGEN

included

QIAamp DNA Stool
Mini Kit (50)

51 504

QIAGEN

non included

The use of carrier RNA is critical for the extraction efficiency and,
consequently, for DNA/RNA yield. To increase the stability of the carrier
RNA provided with the QIAamp Viral RNA Mini Kit/QIAamp UltraSens
Virus Kit/QIAamp DSP Virus Kit, we recommend the following procedure:
a.

Resuspend the lyophilised carrier RNA prior to first use of the
extraction kit in 310 µl of the elution buffer provided with the kit (final
concentration 1 µg/µl, do not use lysis buffer). Portion this carrier
RNA solution into a number of aliquots adequate to your needs and
store them at -20°C. Avoid repeated thawing (> 2 x) of a carrier RNA
aliquot.

b.

Before the beginning of each extraction, a mixture of lysis buffer and
carrier RNA (and Internal Control, where applicable, see 7.2 Internal
Control) should be prepared freshly according to the following
pipetting scheme:
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For use of QIAamp Viral RNA Mini Kit:
Number of samples

1

12

Lysis buffer AVL

560 µl

6,720 µl

Carrier RNA (1 µg/µl)

5.6 µl

67.2 µl

565.6 µl

6,787.2 µl

560 µl

each 560 µl

Total Volume
Volume per extraction

For use of QIAamp UltraSens Virus Kit:
Number of samples

1

12

Lysis buffer AC

800 µl

9,600 µl

Carrier RNA (1 µg/µl)

5.6 µl

67.2 µl

805.6 µl

9,667.2 µl

800 µl

each 800 µl

Total Volume
Volume per extraction

For use of QIAamp DSP Virus Kit:
Number of samples

1

Lysis buffer AL

500 µl

6,000 µl

Carrier RNA (1 µg/µl)

5.6 µl

67.2 µl

505.6 µl

6,067.2 µl

500 µl

each 500 µl

Total Volume
Volume per extraction

c.

12

Please use the freshly prepared mixture of lysis buffer and carrier
RNA instantly for extraction. Storage of the mixture is not possible.

y

The QIAamp UltraSens Virus Kit allows a sample concentration. If you
use sample material other than serum or plasma, please add at least
50 % (v/v) of negative human plasma to the sample.

y

When using isolation protocols with ethanol-containing washing buffers,
please carry out an additional centrifugation step (three minutes,
13,000 rpm) before the elution to remove any remaining ethanol. This
prevents possible inhibition of PCR.

y

The artus HAV TM RT-PCR Kit v2.0 should not be used with phenolbased isolation methods.
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Important: The Internal Control of the artus HAV TM RT-PCR Kit v2.0 can be
used directly in the isolation procedure (see 7.2 Internal Control).

7.2 Internal Control
An Internal Control (HAV TM IC) is supplied. This allows the user both to
control the RNA isolation procedure and to check for possible
PCR inhibition (see Fig. 1). For this application, add the Internal Control to
the isolation at a ratio of 0.1 µl per 1 µl elution volume. For example, using the
QIAamp UltraSens Virus Kit the RNA is eluted in 60 µl AVE buffer. Hence, 6 µl
of the Internal Control should be added initially. If you elute e.g. in 50 µl, then
use the corresponding volume of 5 µl. The quantity of Internal Control used
depends only on the elution volume. The Internal Control and carrier RNA
(see 7.1 RNA Isolation) should be added only
y

to the mixture of lysis buffer and sample material or

y

directly to the lysis buffer.

The Internal Control must not be added to the sample material directly. If
added to the lysis buffer please note that the mixture of Internal Control and
lysis buffer/carrier RNA has to be prepared freshly and used instantly (storage
of the mixture at room temperature or in the fridge for only a few hours may
lead to Internal Control failure and a reduced extraction efficiency). Please do
not add the Internal Control and the carrier RNA to the sample material
directly.
The Internal Control can optionally be used exclusively to check for
possible PCR inhibition (see Fig. 2). For this application, add 2 µl of the
Internal Control per reaction directly to the mixture of HAV TM Master 1 & 2
(30 µl). For each PCR reaction use 30 µl of the Master Mix produced as
*

described above and add 20 µl of the purified sample. If you are preparing a
PCR run for several samples please increase the volume of the mixture of

*

The volume increase caused by adding the Internal Control is neglected when preparing
the PCR assay. The sensitivity of the detection system is not impaired.
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HAV TM Master 1 & 2 and the Internal Control according to the number of
samples (see 7.4 Preparing the PCR).

7.3 Quantitation
The enclosed Quantitation Standards (HAV TM QS 1 - 4) are treated as
previously purified samples and the same volume is used (20 µl). To generate
a standard curve on an ABI PRISM Sequence Detection System, all four
Quantitation Standards should be used and defined as standards with
specification of the corresponding concentrations (see 7.5 Programming the
ABI PRISM SDS). The import of standard curves from previous runs is not
possible with the ABI PRISM 7000, 7700 and 7900HT SDS software.
Attention: The Quantitation Standards are defined as IU/µl. The following
equation has to be applied to convert the values determined using the
standard curve into IU/ml of sample material:
Result (IU/µl) x Elution Volume (µl)
Result (IU/ml)

=
Sample Volume (ml)

Please note that as a matter of principle the initial sample volume should be
entered in the equation above. This has to be considered when the sample
volume has been changed prior to the nucleic acid extraction (e.g. narrowing
the volume by centrifugation or increase of volume by replenishment to the
volume required for the isolation).
In order to convert the values determined into IU/mg of sample material
please apply the following equation:
Result (IU/µl) x Elution Volume (µl)
Result (IU/mg)

=
Sample Material (mg)

For this purpose it is important to determine the initial weight of the sample
before starting the isolation procedure.
Important: A guideline for the quantitative analysis of artus systems on the
ABI

12

PRISM

7000

SDS

is

provided

at
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www.qiagen.com/Products/ByLabFocus/MDX

(Technical

Note

for

quantitation on the ABI PRISM 7000 SDS).

7.4 Preparing the PCR
Prepare the number of required reaction tubes or a 96-well reaction plate for
the scheduled reactions. Recommended materials are listed in the following
table:
Article

Description

Catalogue
Number

Manufacturer

Retaining
Rack*

Compression
Pad

96-well
optical
reaction
plate

96-Well Optical
Reaction Plate

4 306 737

Applied
Biosystems

no

–

Optical
adhesive
covers

Optical
Adhesive
Covers

4 311 971

Applied
Biosystems

–

yes

Optical
reaction
tubes

ABI PRISM
Optical Tubes,
8 Tubes/Strip

4 316 567

Applied
Biosystems

yes

–

Optical
reaction
tubes

MicroAmp®
Optical Tubes

N8010933

Applied
Biosystems

yes

–

Optical
caps
(flat)

ABI PRISM
Optical Caps,
8 Caps/Strip

4 323 032

Applied
Biosystems

–

no

Attention: The use of reaction tubes for optical analyses with domed caps is
only permitted with the ABI PRISM 7700 SDS and requires an adjustment of
the exposure time (see 7.5.2 Programming the ABI PRISM 7700 SDS,
7.5.2.5 Important Additional Settings).
When preparing the PCR reaction, please make sure that at least one
Quantitation Standard per PCR run as well as one negative control (Water,
PCR grade) are performed in parallel. To generate a standard curve, use all
supplied Quantitation Standards (HAV TM QS 1 - 4) for each PCR run. Before
each use, all reagents need to be thawed completely, mixed (by repeated up

* If the two-part retaining rack is used, it is necessary to open the reaction tubes when
inserting them into and removing them from the rack. In order to avoid contamination
due to this procedure, please use the lower part of the retaining rack only.
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and down pipetting or by inverting the tube several times) and centrifuged
briefly.
If you want to use the Internal Control to monitor the RNA isolation
procedure and to check for possible PCR inhibition, it has already been
added to the isolation (see 7.2 Internal Control). In this case, please use the
following pipetting scheme (for a schematic overview see Fig. 1):

1. Preparation of
Master Mix

2. Preparation of
PCR assay

Number of samples

1

12

HAV TM Master 1

25 µl

300 µl

HAV TM Master 2

5 µl

60 µl

HAV TM IC

0 µl

0 µl

Total Volume

30 µl

360 µl

Master Mix

30 µl

30 µl each

Sample

20 µl

20 µl each

Total Volume

50 µl

50 µl each

If you want to use the Internal Control exclusively to check for
PCR inhibition, it must be added directly to the mixture of HAV TM
Master 1 & 2. In this case, please use the following pipetting scheme (for a
schematic overview see Fig. 2):

1. Preparation of
Master Mix

2. Preparation of
PCR assay

Number of samples

1

12

HAV TM Master 1

25 µl

300 µl

HAV TM Master 2

5 µl

60 µl

HAV TM IC

2 µl

24 µl

Total Volume

32 µl*

384 µl*

Master Mix

30 µl*

30 µl each*

Sample

20 µl

20 µl each

Total Volume

50 µl

50 µl each

Pipette 30 µl of the Master Mix into each required reaction tube or well of the
96-well reaction plate. Subsequently add 20 µl of the eluate from the
RNA isolation. Mix the solution well by repeated up and down pipetting. Close

* The volume increase caused by adding the Internal Control is neglected when preparing
the PCR assay. The sensitivity of the detection system is not impaired.
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the reaction tubes with the corresponding caps or, alternatively, when using a
96-well reaction plate, with optical adhesive covers (Optical Adhesive Covers).
Centrifuge the reaction tubes (in a storage rack for PCR tubes) or the 96-well
reaction plate in a centrifuge with a microtitre plate rotor for 30 seconds at
1,780 x g (4,000 rpm) in order to collect the prepared reaction volume in the
bottom of the tube or well. If such a centrifuge is not at your disposal, please
make sure that both the Master Mix and the sample volume are pipetted to the
bottom of the tubes or wells. Store the prepared reactions at +4°C until the
ABI PRISM SDS Instrument is programmed (see 7.5 Programming the ABI
PRISM SDS) and subsequently transfer them into the instrument.
Attention:
y

When using optical reaction tubes in combination with optical caps,
always insert a retaining rack (96-Well Tray/Retainer Set) into the
instrument (ABI PRISM 7000, 7700 and 7900HT SDS). If the two-part
retaining rack is used, it is necessary to open the reaction tubes when
inserting them into and removing them from the rack. In order to avoid
contamination due to this procedure, please use the lower part of the
retaining rack only.

y

Using 96-well optical reaction plates in combination with optical adhesive
covers requires covering by a compression pad (Optical Cover
Compression Pads).
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Addition of the Internal Control to the Purification Procedure

Purification
Sample/Lysis Buffer
Mixture + 0.1 µl IC* per
1 µl Elution Volume

25 µl
HAV TM
Master 1*

5 µl
HAV TM
Master 2*


20 µl Purified Sample*

30 µl Master Mix*


Optical Reaction
Plate/Tube

ABI PRISM SDS

Fig. 1:

Schematic workflow for the control of both the purification
procedure and PCR inhibition.
*

Please make sure that the solutions are thawed completely,
mixed well and centrifuged briefly.
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Addition of the Internal Control into the artus Master

2 µl IC*

25 µl
HAV TM
Master 1*

5 µl
HAV TM
Master 2*


Purification

32 µl Master Mix*

20 µl Purified Sample*

30 µl Master Mix*


Optical Reaction
Plate/Tube

ABI PRISM SDS

Fig. 2:

Schematic workflow for the control of PCR inhibition.
*

Please make sure that the solutions are thawed completely,
mixed well and centrifuged briefly.
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7.5 Programming the ABI PRISM SDS
The software of the ABI PRISM 7000, 7700 and 7900HT Sequence Detection
Systems (SDS) requires some additional information before starting the PCR
run. The programming procedures of the instruments, however, differ
considerably from each other, which is why they are treated in separate
chapters as follows.

7.5.1 Programming the ABI PRISM 7000 SDS
For the detection of HAV RNA, create a profile on your ABI PRISM 7000 SDS
according to the following six steps (7.5.1.1 - 7.5.1.6). All specifications refer
to the ABI PRISM 7000 SDS software version 1.0.1. For programming details
of the ABI PRISM 7000 SDS, please refer to the ABI PRISM 7000 SDS User
Guide. For a better overview, the software settings are framed in bold black.
7.5.1.1

Pre-Settings for Creating a New PCR Run

Select the item New from the File menu on the ABI PRISM 7000 SDS and
programme the following initial settings for the new document (see Fig. 3). A
backup template (SDS Template [*.sdt]) is available from the Template list or
by selection using the Browse function (see 7.5.1.5 Saving the PCR Run).
Confirm your pre-settings (OK).

Fig. 3: Pre-settings for creating a new PCR run (New Document).
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7.5.1.2

Creating/Selecting the Detectors

With the help of the submenu Detector Manager from the Tools menu, assign
the corresponding detector dyes to the file. For the detection of HAV RNA as
well as the Internal Control by means of the artus HAV TM RT-PCR Kit v2.0,
the reporters/quenchers listed in the following table are to be defined:
Detection

Reporter

Quencher

HAV RNA

FAM

none

Internal Control (HAV TM IC)

VIC

none

To create these detectors, select the option File (bottom left of the Detector
Manager) and subsequently the option New.

Fig. 4: Creating the HAV specific detector
(Detector Manager).

Fig. 5: Creating the IC specific detector
(Detector Manager).

For the detection of HAV RNA define the reporter/quencher combination
FAM/none in the new window. For the detection of the Internal Control, select
the combination VIC/none (as shown in Fig. 4 and Fig. 5). By confirming the
input data (OK), return to the Detector Manager. Mark the newly created
detectors and transfer each selection to the Well Inspector by clicking on the
option Add to Plate Document (see Fig. 6). Close the window (Done).

artus HAV TM RT-PCR Kit v2.0 12/2010
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Fig. 6: Selecting the detectors (Detector Manager).

7.5.1.3

Assigning the Necessary Information to the Plate Positions

Open Well Inspector from the View menu to find the detectors selected under
7.5.1.2 (see Fig. 7).

Fig. 7: Assigning the necessary information to the plate positions (Well Inspector).

Mark the plate positions reserved for the detection of HAV RNA. Assign the
selected detectors to these positions by activating the Use option of both
detectors, upon which a tick will appear. For the denomination of each single
reaction, select the corresponding position on the plate and enter the name
(Sample Name). Please note that preparations with an identical Sample Name
and an identical detector assignment will be identified as replicates by the
software and will be averaged with respect to the quantified pathogen load.
Then select the corresponding function (Task) for each sample type according
to the following table:

20
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Sample Type

Function
(Task)

Concentration
(Quantity)

Reporter

Quencher

Sample

Unknown

-

FAM

none

NTC

-

FAM

none

Standard

see 1. Contents

FAM

none

Non-template
control
Standard

To generate a standard curve, use all supplied Quantitation Standards
(HAV TM QS 1 - 4) per PCR run and enter the corresponding concentrations
(see 1. Contents) for each standard (Quantity). Please note that for a PCR
run with the artus HAV TM RT-PCR Kit v2.0, ROX has to be set as a passive
reference (Passive Reference). The equal distribution of the ROX dye in all
PCR preparations of a lot by mixing of the HAV TM Master 1 & 2 guarantees
the recognition and calculation of tube-to-tube variations (fluorescence
differences between several PCR preparations) by means of the Sequence
Detection Software (normalization).
7.5.1.4

Creating the Temperature Profile

To create a temperature profile, switch from the Setup level to the Instrument
level in the software. Enter the temperature profile specific for the detection of
HAV RNA according to Fig. 8. Make sure that the reaction volume is set to
50 µl. The option 9600 Emulation should be activated, the pre-settings of the
Auto

Increment

should

remain

unchanged

(Auto Increment: 0.0°C,

0.0 Seconds).

artus HAV TM RT-PCR Kit v2.0 12/2010
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Fig. 8: Creating the temperature profile.

7.5.1.5

Saving the PCR Run

Save the settings (Setup) as a template in order to make use of them again
later in a modified or unchanged form. By saving the settings as a SDS
Template

(*.sdt)

in

the

Template

[C:]\Program Files\ABI PRISM 7000\Templates,

Directory
created

(Local
by

Disk
Applied

Biosystems), this file may be selected directly in the New Document window
from the Template drop-down list. Copies stored in other folders have to be
opened via Browse. Before starting the PCR run, save it again as a SDS
Document (*.sds), in order to guarantee the saving of the data that will be
collected during the course of the PCR.
7.5.1.6

Starting the PCR Run

Start the PCR run by selecting the option Start from the menu item Instrument
or the field Start on the Instrument level.
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7.5.2 Programming the ABI PRISM 7700 SDS
For the detection of HAV RNA, create a profile on your ABI PRISM 7700 SDS
according to the following seven steps (7.5.2.1 - 7.5.2.7). All specifications
refer to the ABI PRISM 7700 SDS software version 1.9.1. For programming
details of the ABI PRISM 7700 SDS, please refer to the ABI PRISM 7700 SDS
User`s Manual. For a better overview, the software settings are framed in bold
black.
7.5.2.1

Pre-settings for Creating a New PCR Run

Select the item New Plate from the File menu on the ABI PRISM 7700 SDS
and programme the following initial settings for the new document (see Fig. 9).
Confirm the pre-settings (OK).

Fig. 9: Pre-settings for creating a new PCR run (New Plate).

7.5.2.2

Selecting the Fluorescence Dyes and Assigning the Sample
Type

With the help of the Sample Type Setup (Setup level: Sample Type/Sample
Type Setup) assign the corresponding detector dyes and the corresponding
sample type to the file. For the detection of HAV RNA as well as the Internal
Control

by

means

of

the

artus HAV TM RT-PCR

Kit

v2.0,

the

reporters/quenchers listed in the following table are to be defined:
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Detection

Reporter

Quencher

HAV RNA

FAM

TAMRA

Internal Control (HAV TM IC)

VIC

TAMRA

For the analysis of HAV RNA by means of the artus HAV TM RT-PCR Kit
v2.0, select the reporter dye FAM as given in the table. This applies to
standards (STND) and samples (UNKN) as well as to non-template controls
(UNKN). For the analysis of the Internal Control (IPC+), define VIC as
reporter. As quencher set TAMRA. The assignment of the dyes and sample
types in the window Sample Type Setup is shown in Fig. 10.

Fig. 10: Selecting the fluorescence
(Sample Type Setup).

dyes

and

assigning

the

sample

type

Please assign the sample type to a corresponding function (Acronym)
according to the following table:
Function
(Acronym)

Concentration
(Quantity)

Reporter

Quencher

Sample

UNKN

-

FAM

TAMRA

Non-template
control

UNKN

-

FAM

TAMRA

Standard

STND

see 1. Contents

FAM

TAMRA

Sample Type
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7.5.2.3

Assigning the Necessary Information to the Plate Positions

For the assignment of the detectors and sample types to the individual plate
positions, select the corresponding fields. Then open the dialogue window
Dye Layer on the Setup level and assign the corresponding reporter. Upon
activation of the pop-up menu Sample Type, you will find the sample types
assigned to the reporter in the Sample Type Setup in the appearing list
(see Fig. 11). Select the adequate sample type (see Table under 7.5.2.2) and
assign the remaining plate positions by means of the Dye Layers and the
Sample Type menu. A name may be assigned to each sample in the field
Sample Name. Fields defined as Replicates (entering of the name of the
reference sample into the Replicate column) are averaged by the software
with respect to the quantified pathogen load and the standard deviation will be
calculated.

Fig. 11/12: Assigning the necessary information to the plate positions.

To generate a standard curve, use all supplied Quantitation Standards
(HAV TM QS 1 - 4) per PCR run and enter the corresponding concentrations
(see 1. Contents) for each standard into the field Quantity (see Fig. 12). This
is only possible, however, if the positions reserved for standards were defined
as such before by means of the Sample Type menu.
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7.5.2.4

Creating the Temperature Profile

To create a temperature profile, switch to the Thermal Cycler Conditions menu
on the Setup level. Enter the temperature profile specific for the detection of
HAV RNA according to Fig. 13. Make sure that the reaction volume is set to
50 µl. The pre-settings of the Ramp times and of the Auto Increment remain
unchanged (Ramp Time: 0:00, Auto Increment: 0.0°C, 0.0 Seconds).

Fig. 13: Creating the temperature profile.

In addition, the Thermal Cycler Conditions menu contains the option Show
Data Collection. By selecting this option the window depicted in Fig. 14 is
opened. Each ramp and each plateau temperature shows a Data Collection
Icon, which illustrates the data being collected at this stage of the run.
Remove all symbols except the one for the Annealing step (Stage3/Step2) in
order to exclude unnecessary fluorescence measurements. The total run time
and the data quantity will thus be kept at a minimum.
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Fig. 14: Data collection.

7.5.2.5

Important Additional Settings

For the setting of the exposure time (excitation of the fluorescence dyes) as
well as for the selection of the Pure Spectra/Background files, switch from the
Setup level to the Analysis level. Select the activated sub-item Advanced
Options to be found in the Instrument menu under Diagnostics. Adjust the
settings according to Fig. 15. By inactivating the optional function Spectra
Components (Analysis) the actual calibration files stored in the file Spectra
Components at the moment of data generation are automatically used when
re-evaluating already analysed runs. For an analysis of previous runs by using
newly entered Spectra Components, activate these two fields. Please note
that for a PCR run with the artus HAV TM RT-PCR Kit v2.0, ROX has to be
set as a passive reference (Reference). The equal distribution of the ROX dye
in all PCR preparations of a lot by mixing of the HAV TM Master 1 & 2
guarantees the recognition and calculation of tube-to-tube variations
(fluorescence differences between several PCR preparations) by means of the
Sequence Detection Software (normalization).
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Attention: When using 96-well reaction plates for optical measurements in
combination with optical adhesive covers or optical reaction tubes with flat
caps, the exposure time is ten milliseconds. If you use optical reaction tubes
with domed caps, you have to adjust this exposure time to 25 milliseconds.

Fig. 15: Important additional settings (Advanced Options).

7.5.2.6

Saving the PCR Run

Save the settings (Setup) as a template in order to make use of them again
later in a modified or unchanged form. For this purpose store the file in the
Stationary File Format. Before starting a newly programmed PCR run, please
save it again in the Normal File Format in order to guarantee the saving of
data that will be collected during the course of the PCR.
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7.5.2.7

Starting the PCR Run

Start the PCR run by selecting the option Run from the menu item Instrument
or the field Run on the Analysis level.
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7.5.3 Programming the ABI PRISM 7900HT SDS
For the detection of HAV RNA, create a profile on your ABI PRISM 7900HT
SDS according to the following six steps (7.5.3.1 - 7.5.3.6). All specifications
refer to the ABI PRISM 7900HT SDS software version 2.1. For programming
details of the ABI PRISM 7900HT SDS, please refer to the ABI PRISM
7900HT SDS User Guide. For a better overview, the software settings are
framed in bold black.
7.5.3.1

Pre-Settings for Creating a New PCR run

Select the item New from the File menu on the ABI PRISM 7900HT SDS and
programme the following initial settings for the new document (see Fig. 16). A
backup template (ABI PRISM SDS Template Document [*.sdt]) is available
from the Template list or by selection using the Browse function (see
7.5.3.5 Saving the PCR Run). Confirm the pre-settings (OK).
Attention: The artus HAV TM RT-PCR Kit v2.0 may not be used in
combination with the 384 plate format of the ABI PRISM 7900HT SDS.

Fig. 16: Pre-settings for creating a new PCR run (New Document).
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7.5.3.2

Creating/Selecting the Detectors

With the help of the submenu Detector Manager from the Tools menu
(alternatively:

Setup

level/Add

Detector

select

function),

assign

the

corresponding detector dyes to the file. For the detection of HAV RNA as well
as the Internal Control by means of the artus HAV TM RT-PCR Kit v2.0, the
reporters/quenchers listed in the following table are to be defined:
Detection

Reporter

Quencher

HAV RNA

FAM

Non Fluorescent

Internal Control (HAV TM IC)

VIC

Non Fluorescent

To create these detectors, select the option New (bottom left of the Detector
Manager).

Fig. 17: Creating
the
HAV specific
detector (Detector Manager).

Fig. 18: Creating the IC specific detector
(Detector Manager).

For the detection of HAV RNA define the reporter/quencher combination
FAM/Non Fluorescent in the new window. For the detection of the Internal
Control, select the combination VIC/Non Fluorescent (as shown in Fig. 17
and Fig. 18). By confirming the input data (OK), return to the Detector
Manager. Mark the newly created detectors and transfer each selection to the
Setup level by clicking on the option Copy to Plate Document (see Fig. 19).
Close the window (Done).
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Fig. 19: Selecting the detectors (Detector Manager).

7.5.3.3

Assigning the Necessary Information to the Plate Positions

After having closed the Detector Manager (Done) the detectors selected under
7.5.3.2 are found on the Setup level listed in a table (see Fig. 20).

Fig. 20: Assigning the necessary information to the plate positions.

Mark the plate positions reserved for the detection of HAV RNA. Assign the
selected detectors to these positions by activating the Use option of both
detectors, upon which a cross will appear. For the denomination of each
single reaction, select the corresponding position on the plate and enter the
name (Sample Name). Please note that preparations with an identical Sample
Name and an identical detector assignment will be identified as replicates by
the software and will be averaged with respect to the quantified pathogen
load. Then select the corresponding function (Task) for each sample type
according to the following table:
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Sample Type

Function
(Task)

Concentration
(Quantity)

Reporter

Quencher

Sample

Unknown

-

FAM

Non Fluorescent

NTC

-

FAM

Non Fluorescent

Standard

see 1. Contents

FAM

Non Fluorescent

Non-template
control
Standard

To generate a standard curve, use all supplied Quantitation Standards
(HAV TM QS 1 - 4) per PCR run and enter the corresponding concentrations
(see 1. Contents) for each standard (Quantity). Please note that for a PCR
run with the artus HAV TM RT-PCR Kit v2.0, ROX has to be set as a passive
reference (Passive Reference). The equal distribution of the ROX dye in all
PCR preparations of a lot by mixing of the HAV TM Master 1 & 2 guarantees
the recognition and calculation of tube-to-tube variations (fluorescence
differences between several PCR preparations) by means of the Sequence
Detection Software (normalization).
7.5.3.4

Creating the Temperature Profile

To create a temperature profile, switch from the Setup level to the Instrument
level in the software. Enter the valid temperature profile for the detection of
HAV RNA according to Fig. 21. Make sure that the reaction volume is set to
50 µl. The option 9600 Emulation should be activated, the pre-settings of the
Ramp

time

and

the

Auto

Increment

should

remain

unchanged

(Ramp Time: 0:00, Auto Increment: 0.0°C, 0.0 Seconds).
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Fig. 21: Creating the temperature profile.

In addition, the Instrument level contains the option Data Collection. By
selecting this option the window depicted in Fig. 22 is opened. Each ramp and
each plateau temperature shows a Data Collection Icon, which illustrates the
data being collected at this stage of the run. Remove all symbols except the
one for the Annealing step (Stage3/Step2) by clicking on them in order to
exclude unnecessary fluorescence measurements. The total run time and the
data quantity will thus be kept at a minimum.
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Fig. 22: Data collection.

7.5.3.5

Saving the PCR Run

Save the settings (Setup) as a template in order to make use of them again
later in a modified or unchanged form. By saving the settings as an ABI
PRISM SDS Template Document (*.sdt) in the Template Directory
([D:]\Program Files\Applied Biosystems\SDS 2.1\Templates,

created

by

Applied Biosystems), this file may be selected directly in the New Document
window from the Template list. Copies stored in other folders have to be
opened via Browse. Before starting the PCR run, save it again as an ABI
PRISM SDS Document (*.sds) in order to guarantee the saving of the data
that will be collected during the course of the PCR.
7.5.3.6

Starting the PCR Run

Start the PCR run by selecting the option Start from the menu item Instrument.
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8. Data Analysis
A valid calibration of the dyes (Pure Spectra Component File) and the
background (Background Component File) is necessary when putting the
instruments into operation. These calibration files are required for the exact
calculation of the results as follows:
All interfering signals generated by the instruments which influence the
measurement are eliminated by the Sequence Detection Software of the ABI
PRISM Sequence Detection Systems by means of the Background
Component File.
Furthermore, interferences appear during multicolour analyses between the
emission spectra of the single fluorescence dyes. The software of the ABI
PRISM SDS compensates these interferences by calculations using the
spectrum data of the individual dyes stored in the Pure Spectra Component
File. The software uses the same file for the assignment of the fluorescence
data comprising the entire measurable spectrum collected in the course of the
PCR to the programmed detectors. The fluorescence data of the individual
dyes are subsequently divided by the value obtained for the signal of the
passive reference (ROX) in order to account for tube-to-tube variations
(fluorescence differences between several PCR preparations). The thus
normalized signals may then be evaluated by means of the Amplification Plot.
The calibration files used for the evaluation of a PCR run are automatically
stored with the saving of the run. If no calibration files are installed, please
create these files according to the instructions given in the ABI PRISM SDS
User Guide/Manual.
If more than one artus TM PCR system is integrated in your PCR run (note
temperature profile), these assays should be analysed separately. Samples
with an identical Sample Name and an identical detector assignment will
automatically be identified as replicates by the ABI PRISM 7000 and 7900HT
SDS Software and will be averaged with respect to the quantified pathogen
load.
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The following results are possible:
1. A FAM fluorescence signal is detected.
The result of the analysis is positive: The sample contains HAV RNA.
In this case, the detection of a VIC fluorescence signal (Internal Control) is
dispensable, since high initial concentrations of HAV RNA (positive FAM
fluorescence signal) can lead to a reduced or absent fluorescence signal of the
Internal Control (competition).

2. No FAM fluorescence signal is detected. At the same time, a VIC
fluorescence signal from the Internal Control appears.
In the sample no HAV RNA is detectable. It can be considered
negative.
In the case of a negative HAV RT PCR the detected signal of the Internal Control
rules out the possibility of RT PCR inhibition.

3. Neither a FAM fluorescence signal nor a VIC fluorescence signal is
detected.
No result can be concluded.
Information regarding error sources and their solution can be found in
9. Troubleshooting.

Examples of positive and negative PCR reactions are given in Fig. 23 / 24
(ABI PRISM 7000 SDS), 25 / 26 (ABI PRISM 7700 SDS) and 27 / 28 (ABI
PRISM 7900HT SDS).
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Fig. 23: Detection of the Quantitation Standards (HAV TM QS 1 - 4)
by measurement of the FAM fluorescence signal (ABI PRISM
7000 SDS). NTC: non-template control (negative control).

Fig. 24: Detection of the Internal Control (IC) by measurement of the
VIC fluorescence signal (ABI PRISM 7000 SDS) with
simultaneous amplification of the Quantitation Standards
(HAV TM QS 1 - 4). NTC: non-template control (negative
control).
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Fig. 25: Detection of the Quantitation Standards (HAV TM QS 1 - 4)
by measurement of the FAM fluorescence signal (ABI PRISM
7700 SDS). NTC: non-template control (negative control).

Fig. 26: Detection of the Internal Control (IC) by measurement of the
VIC fluorescence signal (ABI PRISM 7700 SDS) with
simultaneous amplification of the Quantitation Standards
(HAV TM QS 1 - 4). NTC: non-template control (negative
control).
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Fig. 27: Detection of the Quantitation Standards (HAV TM QS 1 - 4)
by measurement of the FAM fluorescence signal (ABI PRISM
7900HT SDS). NTC: non-template control (negative control).

Fig. 28: Detection of the Internal Control (IC) by measurement of the
VIC fluorescence signal (ABI PRISM 7900HT SDS) with
simultaneous amplification of the Quantitation Standards
(HAV TM QS 1 - 4). NTC: non-template control (negative
control).
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9. Troubleshooting
No FAM fluorescence signal with positive controls (HAV TM QS 1 - 4):
y

The selected detection dye for PCR data analysis does not comply with
the protocol.
For data analysis select the detection dye FAM for the analytical
HAV RT PCR and the detection dye VIC for the Internal Control RT
PCR.

y

The settings used for the data analysis under Options (Extension Phase
Data Extraction) do not correspond to the settings of the Data Collection
(for ABI PRISM 7700 SDS see 7.5.2.4 Creating the Temperature
Profile, for ABI PRISM 7900HT SDS see 7.5.3.4 Creating the
Temperature Profile).
Analyse the PCR run with corrected settings and repeat the data
analysis (Analysis).

y

Incorrect programming of the temperature profile of the ABI PRISM
Sequence Detection System.
Compare

the

temperature

profile

with

the

protocol

(see

7.5 Programming the ABI PRISM SDS).
y

Incorrect configuration of the PCR reaction.
Check your work steps by means of the pipetting scheme (see
7.4 Preparing the PCR) and repeat the PCR, if necessary.

y

The storage conditions for one or more kit components did not comply
with the instructions given in 2. Storage or the artus HAV TM RT-PCR Kit
v2.0 had expired.
Please check the storage conditions and the expiration date (see the
kit label) of the reagents and use a new kit, if necessary.

Weak or no signal of the Internal Control (VIC fluorescence signal) and
simultaneous absence of a FAM fluorescence signal for the specific
HAV RT PCR:
y

The PCR conditions do not comply with the protocol.
Check the PCR conditions (see above) and repeat the PCR with
corrected settings, if necessary.
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y

The PCR was inhibited.
Make

sure that you use

a

recommended

isolation method

(see 7.1 RNA Isolation) and stick closely to the manufacturer’s
instructions.
Make sure that during the RNA isolation the recommended additional
centrifugation step has been carried out before the elution in order to
remove any residual ethanol (see 7.1 RNA Isolation).
y

RNA was lost during extraction.
If the Internal Control had been added to the extraction, an absent
signal of the Internal Control can indicate the loss of RNA during the
extraction. Make sure that you use a recommended isolation method
(see 7.1 RNA Isolation) and stick closely to the manufacturer’s
instructions.

y

The storage conditions for one or more kit components did not comply
with the instructions given in 2. Storage or the artus HAV TM RT-PCR Kit
v2.0 had expired.
Please check the storage conditions and the expiration date (see the
kit label) of the reagents and use a new kit, if necessary.

A FAM fluorescence signal of the analytical RT PCR with the negative
controls:
y

A contamination occurred during preparation of the PCR.
Repeat the PCR with new reagents in replicates.
If possible, close the PCR tubes directly after addition of the sample to
be tested.
Strictly pipette the positive controls at last.
Make sure that work space and instruments are decontaminated at
regular intervals.

y

A contamination occurred during extraction.
Repeat the extraction and PCR of the sample to be tested using new
reagents.
Make sure that work space and instruments are decontaminated at
regular intervals.
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If you have any further questions or if you encounter problems, please contact
our Technical Service.

10. Specifications
10.1 Analytical Sensitivity
In order to determine the analytical sensitivity of the artus HAV TM RT-PCR
st

Kit v2.0, a dilution series of the “1 International HAV standard” (WHO, NIBSC
00/560) has been set up from 1 to nominal 0.000316 IU/µl and analysed by
means of the ABI PRISM 7000, 7700 and 7900HT Sequence Detection
Systems with the help of the artus HAV TM RT-PCR Kit v2.0. Testing for all
instruments was carried out on three different days on eight replicates. The
results were determined by a probit analysis. A graphical illustration of the
probit analysis (ABI PRISM 7000 SDS) is shown in Fig. 29.

Detection limit (p = 0.05)
ABI PRISM 7000 SDS

0.2 IU/µl

ABI PRISM 7700 SDS

0.1 IU/µl

ABI PRISM 7900HT SDS

0.1 IU/µl

This means that there is a 95 % probability that 0.2 IU/µl (ABI PRISM 7000
SDS), 0.1 IU/µl (ABI PRISM 7700 SDS) and 0.1 IU/µl (ABI PRISM 7900HT
SDS) will be detected.
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Probit analysis: Hepatitis A virus (ABI PRISM 7000 SDS)

Fig. 29: Analytical sensitivity of the artus HAV TM RT-PCR Kit v2.0
(ABI PRISM 7000 SDS).

10.2 Specificity
The specificity of the artus HAV TM RT-PCR Kit v2.0 is first and foremost
ensured by the selection of the primers and probes, as well as the selection of
stringent reaction conditions. The primers and probes were checked for
possible homologies to all in gene banks published sequences by sequence
comparison analysis. The detectability of all relevant genotypes has thus been
ensured by a database alignment and by a PCR run on an ABI PRISM 7000
SDS with the following genotypes (see Table 1):
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Table 1: Testing of the specificity of relevant genotypes.
HAV
(FAM)

Internal
Control
(VIC)

Cell-culture
material¤

+

+

Genotype IB

Cell-culture
material¤

+

+

HAV 9F94

Genotype II

Synthetic nucleic
acid

+

+

HAV HMH

Genotype IIIA

Cell-culture
material¤

+

+

HAV SLF-88

Genotype VII

Synthetic nucleic
acid

+

+

Hepatitis Avirus strain

Genotypes

Source

HAV GBM

Genotype IA

HAV HM175

¤

Institute for Virology, University of Bremen, Germany

Moreover, the specificity was validated with 30 different HAV negative plasma
samples. These did not generate any signals with the HAV specific primers
and probes, which are included in the HAV TM Master 1 & 2.
To determine the specificity of the artus HAV TM RT-PCR Kit v2.0 the control
group listed in the following table (see Table 2) has been tested for crossreactivity. None of the tested pathogens has been reactive.
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Table 2: Testing the specificity of the kit with potentially cross-reactive pathogens.
HAV
(FAM)

Internal Control
(VIC)

Human herpesvirus 1 (Herpes simplex virus 1)

-

+

Human herpesvirus 2 (Herpes simplex virus 2)

-

+

Human herpesvirus 3 (Varicella-zoster virus)

-

+

Human herpesvirus 5 (Cytomegalovirus)

-

+

Human immunodeficiency virus

-

+

Hepatitis B virus

-

+

Hepatitis C virus

-

+

Echovirus 6

-

+

Echovirus 9

-

+

Echovirus 11

-

+

Echovirus 22

-

+

Echovirus 24

-

+

Rhinovirus

-

+

Poliovirus 2

-

+

Enterovirus 71

-

+

Coxsackievirus A9

-

+

Coxsackievirus A16

-

+

Coxsackievirus B5

-

+

Control group

10.3 Precision
The precision data of the artus HAV TM RT-PCR Kit v2.0 allow the
determination of the total variance of the assay. The total variance consists of
the intra-assay variability (variability of multiple results of samples of the
same concentration within one experiment), the inter-assay variability
(variability of multiple results of the assay generated on different instruments
of the same type by different operators within one laboratory) and the
inter-batch variability (variability of multiple results of the assay using
various batches). The data obtained were used to determine the standard
deviation, the variance and the coefficient of variation for the pathogen
specific and the Internal Control PCR.
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Precision data of the artus HAV TM RT-PCR Kit v2.0 have been collected
st

using a 1 IU/µl dilution of the “1 International HAV standard” (WHO, NIBSC
00/560). Testing was performed with eight replicates. The precision data were
calculated on basis of the Ct values of the amplification curves (Ct: threshold
cycle, see Table 3). In addition, precision data for quantitative results in IU/µl
were determined using the corresponding Ct values (see Table 4). Based on
these results, the overall statistical spread of any given sample with the
mentioned concentration is 4.77 % (Ct) or 57.11 % (conc.), for the detection of
the Internal Control 2.62 % (Ct). These values are based on the totality of all
single values of the determined variabilities.
Table 3: Precision data on basis of the Ct values.
Standard
deviation

Variance

Coefficient of
variation [%]

Intra-assay variability:
HAV Standard¤ 1 IU/µl

0.93

0.86

2.93

Intra-assay variability:
Internal Control

0.68

0.46

2.57

Inter-assay variability:
HAV Standard¤ 1 IU/µl

1.23

1.51

3.77

Inter-assay variability:
Internal Control

0.51

0.26

1.94

Inter-batch variability:
HAV Standard¤ 1 IU/µl

1.74

3.04

5.20

Inter-batch variability:
Internal Control

0.84

0.71

3.18

Total variance:
HAV Standard¤ 1 IU/µl

1.57

2.46

4.77

Total variance:
Internal Control

0.69

0.48

2.62

¤

WHO 1st International HAV Standard (NIBSC 00/560)
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Table 4: Precision data on basis of the quantitative results (in IU/µl).
Standard
deviation

Variance

Coefficient of
variation [%]

Intra-assay variability:
HAV Standard¤ 1 IU/µl

0.23

0.56

63.26

Inter-assay variability:
HAV Standard¤ 1 IU/µl

0.63

0.40

65.42

Inter-batch variability:
HAV Standard¤ 1 IU/µl

0.54

0.30

49.07

Total variance:
HAV Standard¤ 1 IU/µl

0.61

0.37

57.11

¤

WHO 1st International HAV Standard (NIBSC 00/560)

10.4 Robustness
The verification of the robustness allows the determination of the total failure
rate of the artus HAV TM RT-PCR Kit v2.0. 30 HAV negative samples of
plasma

were spiked with 0.6 IU/µl elution volume of HAV control RNA

(threefold concentration of the analytical sensitivity limit). After extraction using
the QIAamp DSP Virus Kit (see 7.1 RNA Isolation) these samples were
analysed with the artus HAV TM RT-PCR Kit v2.0. For all HAV samples the
failure rate was 0 %. In addition, the robustness of the Internal Control was
assessed by purification and analysis of 30 HAV negative plasma samples.
The total failure rate was 0 %. Inhibitions were not observed. Thus, the
robustness of the artus HAV TM RT-PCR Kit v2.0 is ≥ 99 %.
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11. Product Use Limitations
y

The artus HAV TM RT-PCR Kit v2.0 is for research use only. Not for
use in diagnostic procedures.

y

No claim or representation is intended for their use for a specific
clinical use (diagnostic, prognostic, or therapeutic). It is the user’s
responsibility to validate the performance of the artus HAV TM RTPCR Kit v2.0 for any particular use.

y

Strict compliance with the user manual is required for optimal PCR
results.

y

Attention should be paid to expiration dates printed on the box and
labels of all components. Do not use expired components.

y

Although rare, mutations within the highly conserved regions of the
viral genome covered by the kit’s primers and/or probe may result in
underquantitation or failure to detect the presence of the virus in
these cases.

12. Safety Information
For safety information of the artus HAV TM RT-PCR Kit v2.0, please consult
the appropriate material safety data sheet (MSDS). The MSDS are available
online

in

convenient

and

compact

PDF

format

at

www.qiagen.com/support/msds.aspx.

13. Quality Control
In accordance with QIAGEN’s ISO 9001 and ISO 13485-certified Total Quality
Management System, each lot of artus HAV TM RT-PCR Kit v2.0 is tested
against predetermined specifications to ensure consistent product quality.
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15. Explanation of Symbols

Use by

Batch code

Manufacturer

Catalogue number
Material number

Handbook
Components
Contains
Number

<N>

Contains sufficient for <N> tests

Temperature limitation

Consult instructions for use

Quantitation Standard

Internal Control
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human in vitro diagnostics. No general patent or other license of any kind other than this specific right of
use from purchase is granted hereby.
Trademarks and Disclaimers
QIAGEN®, QIAamp®, artus®, UltraSens® (QIAGEN Group); ABI PRISM® (Applera Corporation);
MicroAmp®, GeneAmp® (Applied Biosystems).
Registered names, trademarks, etc. used in this document, even when not specifically marked as such,
are not to be considered unprotected by law.
The artus HAV TM RT-PCR Kit v2.0 is for research use only. Not for use in diagnostic procedures.
For up-to-date licensing information and product-specific disclaimers, see the respective QIAGEN kit
handbook or user manual. QIAGEN kit handbooks and user manuals are available at www.qiagen.com
or can be requested from QIAGEN Technical Services or your local distributor.
Limited License Agreement
Use of this product signifies the agreement of any purchaser or user of the artus HAV TM RT-PCR Kit v2.0
to the following terms:
1.

The artus HAV TM RT-PCR Kit v2.0 may be used solely in accordance with the artus HAV TM RT-PCR
Kit v2.0 Handbook and for use with components contained in the Kit only. QIAGEN grants no license
under any of its intellectual property to use or incorporate the enclosed components of this Kit with
any components not included within this Kit except as described in the artus HAV TM RT-PCR Kit v2.0
Handbook and additional protocols available at www.qiagen.com .

2.

Other than expressly stated licenses, QIAGEN makes no warranty that this Kit and/or its use(s) do
not infringe the rights of third-parties.

3.

This Kit and its components are licensed for one-time use and may not be reused, refurbished, or
resold.

4.

QIAGEN specifically disclaims any other licenses, expressed or implied other than those expressly
stated.

5.

The purchaser and user of the Kit agree not to take or permit anyone else to take any steps that
could lead to or facilitate any acts prohibited above. QIAGEN may enforce the prohibitions of this
Limited License Agreement in any Court, and shall recover all its investigative and Court costs,
including attorney fees, in any action to enforce this Limited License Agreement or any of its
intellectual property rights relating to the Kit and/or its components.

For updated license terms, see www.qiagen.com .
© 2008–10 QIAGEN, all rights reserved.
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